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Release Notes:  
Vocollect VoiceLink® 4.2.1 

15 November 2013 
The following release notes describe the new features and existing limitations in this release 
of VoiceLink. 

Features in this Release 
Support for the Talkman® A700 Solution 

Vocollect's newest generation of mobile devices, the Talkman® A700 series, offers a model for 
Bluetooth® connections, a model for wired connections, and a model with an integrated 
scanner. The Talkman A730 is purpose-built for short-range, occasional scanning as part of a 
voice driven workflow.  

This release of VoiceLink offers two voice application options and both provide support for 
querying the amount of runtime left on a battery charge of any A700 solution device, and for 
scanning with the Talkman A730 triggered by a voice command. 

Talkman A700 Battery Life Command 

A new voice command, "Talkman battery status," enables the operator to determine if there is 
sufficient charge on the Talkman A700 battery to complete his or her shift. When the 
operator speaks the command right after going on air, the device responds with the 
percentage of charge remaining on the battery. If the operator speaks the command after 
working for a few minutes, the device gives the amount of runtime remaining in hours and 
minutes. This feature is disabled by default but can be enabled using an advanced task 
package setting in VoiceConsole®: "disableControlFunction_BATTERY_STATUS=0." 

Talkman A730 Voice Scanning 

The new vocabulary word "scan" has been added to the VoiceLink voice application 
(VoiceArtisan-based voice process software). If voice activated scanning is enabled, operators 
using A730 devices can speak this command to scan location check digits, product IDs, carton 
IDs, and other barcode identifiers. This feature is disabled by default but can be enabled by 
checking the UseTriggerScanVocab check box when creating a task package.  

The vocabulary for the command can be replaced with a custom word or phrase by changing 
the Substitution and Display values of VLINK_SCAN_VOCAB in the Phonetic Substitution 
tab of the task package. 

Integration of Personal Voices 

The ArtisanVoiceLinkPersonalVoices_4.2.1.vad available in this release includes the 
new Personal Voices feature. 

Implementers and operators can now demo or use the VoiceLink Selection VoiceApplication 
with a device that speaks with a human-sounding voice rather than a text-to-speech (TTS) 
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engine. The Personal Voices feature allows you to use your own pre-recorded audio files for 
the prompts that operators hear. 

See Vocollect VoiceArtisan® Help for details on Record and Playback, including instructions 
on identifying messages to record, creating audio files from raw recorded data, and including 
audio files in your voice application. Find the Jukebox recording tool on VoiceWorld.com. 

Supported Devices and Voice Software 

For device and Vocollect Voice Software compatibility with your version of VoiceLink, refer to 
Vocollect Product Ordering Guidelines on the Partner Portal. 

  

Supported Environments 
Operating System Windows Server® 2008, 64-bit (x86) and 2008 R2, 64-bit (x86) 

Windows Server 2008, 32-bit (x86) 
Windows Server 2003, 32-bit (x86) 
Red Hat® Enterprise Linux® v. 5 
VMWare ESX v.4.0 running a supported operating system 

Database Microsoft SQL Server® 2012 
Microsoft SQL Server 2008 and 2008 R2 
Oracle® Database 11g and 11g R2 

Web Server Apache Tomcat™ version 6.0 and Java Development Kit version 6.0 
(installed by VoiceLink installation)  

Devices and 
Vocollect Voice 
Software 

For device and Vocollect Voice Software compatibility with your 
version of VoiceLink, refer to Vocollect Product Ordering Guidelines 
on the Partner Portal. 

Client Browser Microsoft Internet Explorer v. 7, v. 8, v. 9 
Mozilla Firefox v. 4.x and newer 
Google Chrome v. 9.x and newer 

Supported 
Languages * 

da_DK = Danish 
nl_NL = Dutch 
en_AU = English, Australian 
en_GB = English, United Kingdom 
en_US = English, United States 
fi_FI = Finnish 

fr_FR = French 
ja_JA = Japanese 
ko_KR = Korean 
es_MX = Latin American Spanish 
pt_BR = Portuguese, Brazilian 
zh_CN = Simplified Chinese 
sv_SE = Swedish 

 

* The features introduced with this release are available only in English at this time. 

  

Import and Export File Changes 
There were no import or export file changes in this release. 

Data Message Changes 
There were no data message changes in this release. 
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Fixes and Enhancements 
ECSs Included in This Release 

Each of the following issues were fixed in an Emergency Customer Shipment (ECS) and 
included in this release.   

Scanning Delay Resolved: Users experienced a delay when scanning at 
priority prompts with the Talkman A730 because the voice application 
waited to turn on the scanner until the entire prompt was spoken. This issue 
has been fixed and integrated in this release. The scanner now turns on 
before the device speaks a priority prompt so that the operator can scan 
during the prompt. 

VLINK-5079, 
ECRT-3333 

Multiple Hints Allowed for Item Verification: If Product Verification 
IDs (PVIDs) were employed to verify products in the Selection 
VoiceApplication (VoiceArtisan-based voice application implementations 
only), the voice application was not using the PVIDs for response 
expressions (hints). As a result, users experienced speech recognition 
problems. This issue has been resolved in the VoiceArtisan Core Library 
version 1.3.0 and integrated in this release. The voice application now 
allows multiple hints and recognizes both check digit and PVID hints for an 
item. 

VLINK-5033, 
ECRT-3333 

Hints Added to Quantity Entries: Because response expressions for 
quantities were not included in the voice application (VoiceArtisan-based 
voice process software), users experienced less than optimal recognition and 
had to repeat responses when speaking large quantities. This issue has been 
fixed in this release; the voice application now includes hints for expected 
quantities when the values are greater than one digit. 

VLINK-3802, 
ECRT-3333 

  

General Considerations and Limitations 
Differences in Voice Process Software 

  Voice Process Software Technologies 
Application 

Workflows and 
Features 

Task-based (TaskBuilder) 
Voice Process Software 

Voice Application-based 
(VoiceArtisan) 

Voice Process Software 

Cycle Counting 
Workflow: assignment 

Inventory Control features are not 
available. Additional fields for 
display data are ignored by the task; 
no support for display devices. 

Implemented as the Inventory 
Control VoiceApplication to 
support display devices. Assignment 
data includes Tie, High, and Image 
fields. (Feature not available in 
VoiceLink.) 

Tie = Number of items per level on 
the pallet 
High = Number of item levels on the 
pallet 
Image = Filename and path for the 
item image 
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  Voice Process Software Technologies 
Application 

Workflows and 
Features 

Task-based (TaskBuilder) 
Voice Process Software 

Voice Application-based 
(VoiceArtisan) 

Voice Process Software 

Cycle Counting 
Workflow: reserve 
chain 

No support for reserve chain; no 
support for display devices. 

If an item count does not equal the 
expected count, display data is sent 
showing the reserve chain (for 
display devices only; feature not 
available in VoiceLink). 

Loading 
Workflow: specify route 

Following the Route prompt, the 
user must speak, "<route number>, 
Ready." 

Following the Route prompt, the user 
must speak only the route number. 
"Ready" is not needed. 

Receiving N/A Available in VoiceDirect only. 
Selection 

Workflow: partial pick 
If two containers are open when 
doing a partial pick, the slot is re-
prompted after the container is 
verified for the first put. 

The operator is prompted to pick the 
remaining quantity without re-
verifying the slot. The location is not 
re-prompted unless a container is 
delivered, a label is printed, or the 
location changes. 

Selection 
Workflow: deliver 

For the direct load option, the task 
sends the Request Container 
message to the host system to get 
the partial container number 
previously spoken by the operator. 
The task then continues with the 
direct load workflow. 

For the direct load option, the voice 
application does not send the Request 
Container message but continues 
with the direct load workflow. 

Vehicle Safety Checks Feature available in VoiceDirect; not 
available in VoiceLink. 

Custom development of a vehicle 
safety check feature in the task 
requires changing the value stored 
in the params.txt task file from 0 to 
1. 

Feature available in VoiceDirect and 
VoiceLink. 

Feature requires custom 
configuration to enable for the Cycle 
Counting and Line Loading 
VoiceApplications. 

Vehicle type/function 
error responses 

If a user speaks an invalid vehicle 
type or function, the task says "Not 
authorized for {Spoken Value}." 
After saying "ready," the operator is 
returned to the original prompt. 

The error message is "Not authorized 
for {Spoken Value}. Try again." The 
operator is automatically prompted 
again for the input and does not need 
to say "ready." 

Vehicle type input 
length 

The user can only enter a maximum 
of two digits at the "Vehicle type" 
prompt. 

The maximum digits allowed value is 
based on the maximum number in 
the Vehicle Type field in the host 
response to the 
prTaskLUTCoreValidVehicleTypes 
LUT. 

Allowed responses at 
various prompts: 

• <Description>, 
correct? 

• <Spoken ID>, 
correct? 

• <Safety check> 
• <Safety check> 

failed, correct? 

The allowed operator responses are 
"yes" or "no." 

The allowed operator responses are 
"yes," "no," "take a break," or "sign 
off." 

Allowed responses to <safety check> 
also include a numeric response. 
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  Voice Process Software Technologies 
Application 

Workflows and 
Features 

Task-based (TaskBuilder) 
Voice Process Software 

Voice Application-based 
(VoiceArtisan) 

Voice Process Software 

Safety check failure 
responses 

If a vehicle fails a safety check, the 
voice application says "Your vehicle 
has failed. Say quick repair or new 
vehicle". The operator must either 
say "quick repair" or "new vehicle". 

The prompt is "Your vehicle has 
failed. Can you do a quick repair?" 
The operator can respond "yes" or 
"no." 

If the operator says "yes," he or she 
can proceed with the quick repair. If 
the operator says "no," he or she is 
returned to the Vehicle Type prompt. 
This change eliminates the need to 
train "quick repair" and "new 
vehicle." 

  

 

Previously Reported Issues 

The following issues were reported in previous releases of VoiceLink and may still occur in 
this release. 

JVM Settings Recommendation: For VoiceLink implementations, 
Vocollect recommends the following Java Virtual Machine settings. 

• Windows Tomcat service settings 
Java Options: -XX:MaxPermSize=256m and -XX:PermSize=256m 
Initial memory pool: 256 MB 
Maximum memory pool: 1024 MB 
Thread stack size: 1024 KB 

• Linux catalina.sh startup script parameters: “-Xmx 1024m” “-Xms 
256” “-Xss 1m” “-XX:MaxPermSize 512m” “-XX:PermSize 256m” 

N/A 

Chrome Limitations:  Google Chrome™ browsers do not support the 
bookmarking functionality in the VoiceLink interface. Chrome users will 
receive a warning message when they attempt to bookmark a filtered table. 

The "Back" button in Google Chrome browsers does not load the previous 
page correctly in the frame for VoiceLink Online Help. This is a known issue 
with Chrome and MadCap Flare, the help authoring tool used for VoiceLink. 
Users have to navigate manually to the previous help topic. 

Workaround: Navigate manually to the previous help topic. 

N/A 

VoiceLink Demo System:  If you create data in SQL Server, save it with 
the Demo System, then load it in an Oracle database via the Demo System, 
the data load will complete successfully but will finish with a "SQL script not 
found" error. After loading this data to Oracle, you cannot perform a file 
import to add data. If you attempt a file import of new data to the Oracle 
database in this scenario, the import will fail, as it will not be able to create 

N/A 
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new data objects. 

Workaround: Ignore the SQL script error. The load of SQL Server data to 
Oracle works correctly despite the error message. 

If you need to import any additional data, it will have to be imported into 
SQL Server prior to the transfer to Oracle. 

IE8 Caching Requires UI Refresh: When a user creates a new object in 
the user interface (for example, a vehicle type) using Microsoft Internet 
Explorer v. 8, that object may not appear immediately on other UI pages and 
menus. This issue is related to how IE8 caches response data. 

Workaround: After creating the new object, clear the browser cache by 
pressing Ctrl-F5, using the Tools > Internet Options menu, or restarting 
the browser. 

VLINK-4863 

Delivery Mappings Do Not Display: If delivery mapping data does not 
display in the user interface following an upgrade to VoiceLink 4.1, check the 
delivery mapping field settings to ensure that they are correct for each site. 
The default setting for VoiceLink 4.1 changed from Customer Number to 
Route, so your mappings to customer numbers will not appear until the 
mapping field has been edited. 

Workaround: Go to Selection > Delivery Mappings and click the 
Change Mapping Field action link. Select "Customer Number" from the 
drop-down menu and click the Change Mapping Field button to save your 
change. 

VLINK-4679 

Linux Installs Error on Existing Accounts: Upon completing a VoiceLink 
installation on a Linux platform using existing accounts for the Tomcat 
Service and/or the Device Proxy Service, the installer may display an error: 
"The installation of Vocollect Enterprise Products is finished, but some errors 
occurred during the install." 

Workaround: In most cases, this error can be ignored. Review the following 
files to ensure that no exceptions were written to the logs during the 
installation process. 

In the VoiceLink installation folder (/opt/Vocollect/VoiceLink): 
• Vocollect_Enterprise_Products_DBInterfaceLog.log 
• Vocollect_Enterprise_Products_InstallLog.log 
• VoiceLink_InstallLog.log 

In the Logs folder (/<InstallDirectory>/Logs): 
• stderr_*.log 
• stdout_*.log 

VLINK-4653 

Loading Route Status Cannot Change: In the Loading VoiceApplication 
interface, users cannot change the status of a route. 

VLINK-4538 
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Cycle Counting PVID Can Produce Error: In the Cycle Counting 
VoiceApplication when an operator is prompted for a check digit, the operator 
can speak either a check digit or a product verification identifier (PVID). 
Responding with a PVID in system-directed Cycle Counting works as 
expected, but in an operator-directed workflow it results in an "invalid 
location" message. 

Workaround: Use only check digits in the operator-directed workflow. 

VLINK-4478 

Printer Name Error in Linux Environment : In the Loading workflow in 
a VoiceLink Linux environment, the operator receives a general task failure 
when he or she specifies a printer name in response to the “Printer?” prompt. 
This error occurs because the VoiceLink Proxy service is not started with 
sufficient permissions on the Linux server during the initial installation and 
cannot complete the print command. 

User interface notification: 
unexpected exception occurred. See log for details. 

Error appearing in the VoiceLink logs: 
java.lang.InternalError: Can't connect to X11 window 
server using ':0.0' as the value of the DISPLAY 
variable 
  

Workaround: After the initial VoiceLink installation on Linux, stop and 
manually restart the vlproxyserver service using a user that has root 
access. See post-installation instructions in the VoiceLink Implementation 
Guide for details. This action will give the proxy user the appropriate level of 
permissions. The restart should only need to be performed once after 
installation. 

VLINK-4438 

JavaScript Updates May Get Ignored: For Vocollect Partners only: 
During the VoiceLink build process in the development environment, the file 
head.ftl controls the loading of concatenated JavaScript source code. The 
JavaScript file reference in head.ftl is set as a static filename rather than a 
variable, so any updates to the JavaScript source will not be included in the 
build. 

Workaround: If you make any changes to .css or .js files (in /web/css and 
/web/scripts, respectively), run the Ant target deploy-direct to generate the 
flattened version of these files. Copy the new .css and .js files from 
/build/VoiceLink/css and /build/VoiceLink/scripts to /web/css and /web/scripts. 
Then rename the files to match what is set in the head.ftl file (in 
/web/decorators). 

VLINK-4362 

Pre-Selected Data Cannot Be Filtered: If a user selects records in a data 
table in the user interface and then applies a filter that reduces the number 
of records from the original selection, the printable view continues to display 
the original, unfiltered dataset. 

Workaround: Select records in the data table with the filter already applied, 
then click "Printable View." 

VLINK-4322 
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Calendar Problems for Thai: When the VoiceLink server is set to the 
Thailand locale, scheduled jobs and license validation may fail because a 
third-party library does not recognize the time/date schema of the Buddhist 
calendar. 

Workaround: Configure the VoiceLink server with a replacement locale that 
uses the Gregorian Calendar. 

VLINK-4305 

Logged Error Can Be Ignored: Your VoiceLink logs may include a 
“NoSuchMethodException” error message on unknown property 
totalItemsPicked. This is a common error caused by VoiceLink charts which 
does not affect functionality. This error can be ignored. 

VLINK-4288 

Operators Cannot Skip a Skip in Cycle Counting: When there are no 
more available cycle counting assignments, an operator will be prompted to 
count any skipped assignments. The operator is unable to skip a previously 
skipped assignment (by saying "skip slot"); instead, the system prompts for 
the same assignment. 

Workaround: Set the assignment as unavailable in the user interface, or the 
operator can specify a new location to count. 

VLINK-4167 

Printing Error after 1000 Rows: The printable version feature for tables 
in the VoiceLink user interface is limited to 1000 data records at one time. If 
you select more than 1000 rows and click the Printable Version link, an error 
message displays. 

VLINK-4120 

Special Characters in UI: If a user enters text that includes the exact, two-
character combination <? in any text field of the user interface and then 
saves the entry, the resulting table display will not align properly. The open 
angle bracket and question mark, entered in that order with no space, is the 
only character combination that causes this issue. 

VLINK-4118 

Proxy Account Lost in Upgrade: During an upgrade of a VoiceLink 
implementation (Windows operating system environment) that uses an 
existing domain level account for the proxy service, the installer does not 
retain the account and password settings. The proxy does not start after the 
upgrade is completed. 

Workaround: Manually reset the account information in the proxy service 
then restart the service. 

VLINK-4096 

Sequential Imports for Same Assignment May Fail: Multiple import 
files for Selection Assignments and Picks that contain data for the same 
assignment and that are run sequentially in the same import job may cause 
errors and generate non-specific error messages in the VoiceLink logs. If the 
last line of the first file and the first line of the second file both contain data 
for the same assignment number, the import of the second file will fail. The 
import failure applies to all data contained in the second file, so data for 
other assignments could be lost. 

The error message that is likely to appear in the logs is "No public method by 
name 'com.vocollect.voicelink.selection.model.Pick.getPicks()'." 

Prevention: Review your import files to ensure that data for a single 
assignment does not carry over into multiple files. 

VLINK-4092 
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Workaround: Determine where the failure occurred, and re-import the 
failed import file(s). Because this issue is caused by import triggers that do 
not reset between files within an import job, running a new import job for the 
affected files is a viable solution. 

Cluster Manager Fails Upgrade: An upgrade in a clustered environment 
will fail because the Cluster Manager prevents the upgrade installer from 
stopping and deleting the existing VocollectWebApplicationsVL service. 

Workaround: Delete the Cluster Resource associated with the 
VocollectWebApplicationsVL service prior to initiating the upgrade. After the 
upgrade is complete on all nodes, add the Cluster Resource again. 

VLINK-4088 

Operator is not Notified when Going Back for Skips: When an operator 
working a Selection assignment issues the "pass assignment" command or 
completes the final pick in the assignment, the voice process software 
prompts the operator to pick a skipped location in that assignment without 
indicating that it is going back for skips. 

VLINK-4049 

Region Number 0 Creates Errors: If VoiceLink is implemented with a 
region numbered zero (0), the system will generate errors. Region numbers 
must be whole numbers greater than 0. 

VLINK-3890 

Imports Fail with Big Numbers: Table-based and file-based import 
processes can fail if a numeric import field contains a value greater than the 
maximum that can be stored in the system. A numeric overflow error is 
generated and logged. 

VLINK-3849 

Imports Allow Duplicate Verification Values: The validations on file 
imports do not prevent duplicate values in spoken verification, scanned 
verification, and check digits fields. For example, the locations file import 
may create duplicate values in the Spoken Location and Check Digits fields. 
When an operator encounters a location with these duplicate values, he or 
she hears "No error message available. To continue say ready." A similar 
scenario occurs with the Speakable Lot field in the lot file import. 

Workaround: Manually edit the values while the operator is signed off. 

1. Operator must sign off from the device. 
2. A user modifies the values of the affected fields via the user interface 

to make them unique. 
3. The operator signs on to the device and can continue working.  

VLINK-3812 

RTF Reports Inconsistent in Reading Layout: Reports that are 
generated in RTF format do not display properly in the Microsoft Word® 
Reading Layout view because text in tables is not resized for display in this 
view. Users may experience this issue when opening emailed reports received 
in Microsoft Outlook® because Word automatically opens the reading layout 
view for emailed documents. 

Workaround: Close the reading layout view to return to print layout or 
normal view. To permanently disable reading layout, open Word and go to 
Tools > Options > General tab and clear the Allow starting in Reading 
Layout checkbox. 

VLINK-3756 
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Asian Languages Require Language Pack for IE: In some versions of 
Microsoft Internet Explorer® East Asian languages such as Korean, 
Japanese, or Chinese characters are not readable. 

Workaround: Install the East Asian language on the client machine on 
which the browser is installed. For example: 

1. On Win XP machines browse to Start menu > Control Panel > 
Regional and Language Options > Languages tab. 

2. Select Install files for East Asian Languages. 
3. Click OK.  

VLINK-3690 

Time Zone Mismatch Causes Error: If an operator works in sites that are 
configured for different time zones, or if the time zone setting for a site in 
VoiceConsole does not match the time zone for the same site in VoiceLink, the 
operator will receive a "Duplicate command detected" error message. 

Workaround: Perform the following steps: 

1. In the user interface, sign off all operator(s). If prompted for a time to 
use in the sign off process, select "earliest available." 

2. Ensure that the time zone settings match in VoiceConsole and in 
VoiceLink for the site. 

3. Restart the VoiceLink Proxy Service (VLProxyServer). If the proxy is 
installed in distributed mode (separate from the VoiceLink server), 
you must restart the VoiceLink service 
(VocollectWebApplicationsVL) instead. 

VLINK-3528 

Reports Do Not Show Items Remaining: Reports that include picks, such 
as reports based on the Selection Assignment report type, use data on items 
picked only. They do not calculate and display data on picks remaining. 

VLINK-3456 

Printed HTML Reports Lose Data: Reports generated in HTML format do 
not print properly from a browser. The generated HTML report is accurate, 
but some information may be lost when printed. 

Workaround: To obtain printed reports, select the existing report, click Edit 
selected report, and choose an alternate option from the Format drop-down 
menu—PDF, RTF, or XLS. 

VLINK-3450 

Service Paths Must Be Updated after Cluster Install: For 
implementations in a Windows cluster environment, the start parameter 
paths for the VocollectWebApplicationVL and VoiceLink Device Proxy 
services have to be modified after the installation is completed. Enter the 
following values. 

VocollectWebApplicationsVL service: C:\Program 
Files\Vocollect\VoiceLink\apache-tomcat-6.0\bin\tomcat6.exe 
//RS//VocollectWebApplicationsVL 

VoiceLink Device Proxy service: C:\Program 
Files\Vocollect\VoiceLink\DeviceProxy\bin\startwatchdog.bat 

VLINK-3424 
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Cluster Logs Directory Can Change to Default Path: When installing in 
a Windows cluster environment, a specific series of actions will cause the 
value for the logs directory location to default to the path for a normal (non-
cluster) installation. 

• On the Application Cluster screen, leave the default value "No" 
selected and click Next. 

• On the Log Files Directory screen, click Previous. 
• Back on the Application Cluster screen, select "Yes" and click Next. 
• Specify a shared folder or accept the default folder on the Shared 

Cluster Folder screen and click Next. Then provide a cluster 
hostname if prompted. 

• The Log Files Directory screen now displays an incorrect default path 
(C:\Program Files\Vocollect\Logs) for a cluster installation. 

Workaround: Manually change the path to the shared directory location 
previously specified on the Shared Cluster Folder screen. 

VLINK-3419 

Chart Settings Important for Correct Display: In the charts feature for 
Selection, settings left blank for Lower Bound and Upper Bound fields may 
result in generating invalid chart data. On launch, some charts will display a 
lower bound of "0" and an upper bound of "1." 

Workaround: The user should enter numeric values for the lower and upper 
bounds on the Edit Chart Settings page. 

If a user selects the Items Picked/Remaining chart and clicks View chart 
settings, the Include Legend option is set to "Yes" by default.  

Workaround: The user may want to prevent the chart legend from 
displaying by clearing the Include Legend check box. 

VLINK-3285 

Role Name Change Prevents Access: If the name of a role to which a user 
is assigned is modified while that user is logged in to the VoiceLink interface, 
the system generates an error message when that user attempts to access the 
Administration tab: "You are not authorized to access the requested 
application resource." Despite the error, the changes to the role name are 
saved. 

Workaround: the affected user should logout and login again to access the 
Administration tab. 

VLINK-3134 

Adding UI Column Requires Painter Function: In "Add Field to 
Import", adding a Boolean field is not handled properly. In the GUI, adding a 
Boolean field requires the use of a painter function. A section has been added 
to the VoiceLink Customization Guide called "Modifying Column Values 
using a Painter Function." See this section for more information. 

CSCPLG-12 
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Spaces in Import Values Must Be Replaced: In some custom 
implementations of VoiceLink where additional fields have been added to the 
Assignment and Picks import records, white spaces are being removed from 
import values. If the character at position 40111 in the import file is a white 
space, then all subsequent white spaces between 40111 and the next non-
white-space character are removed. This scenario can result in additional 
labels being printed. 

Workaround: Replace the white space characters at this position in the 
import file with periods. 

Developer fix:  

1. Replace xercesImpl.jar with sax.jar from http://www.saxproject.org 
2. Upgrade castor-1.0.2.jar to castor-1.2.jar 
3. Configure the castor jar using a castor.properties file with the 

following properties 
# Defines the XML parser to be used by Castor. 
# The parser must implement org.xml.sax.Parser. 
org.exolab.castor.parser=org.xml.sax.helpers.XMLReaderA
dapter 
  
# Defines the (default) XML serializer factory to use 
by Castor, which must 
# implement org.exolab.castor.xml.SerializerFactory; 
default is 
# org.exolab.castor.xml.XercesXMLSerializerFactory 
org.exolab.castor.xml.serializer.factory= 
org.exolab.castor.xml.XercesJDK5XMLSerializerFactory 

  

VLINK-2971 

Line Loading Reports are not Available: Pallet manifest reports are not 
available from the Line Loading VoiceApplication. 

VLINK-2934 

Duplicate Records Exported for Chase Picks: In Selection, after a pick 
from a chase assignment is picked, two records for that pick are exported in 
the Picks export file (or table-to-table export). 

• The first record is expected, and is mapped to the original 
assignment number. 

• The second record is extraneous, and is identical to the first record 
except that contains the chase assignment number and a sequence 
number of 0. This second record is not understood by the WMS after 
export, and cannot be processed properly. 

VLINK-2762 

Container Numbers Can Be Duplicated Across Regions: A new 
container created in a warehouse with one region allowing system-generated 
container numbers and another region allowing operator-generated container 
numbers, may be assigned a container number that already exists in the 
system. 

 Workaround: Ensure that the container numbers used by operators in 
regions that allow operator-generated container numbers are well outside of 
the range of the numbers used for system-generated container numbers. 
Keep in mind that system-generated container numbers increment by one. 
This situation only exists if you have both types of regions mentioned. 

VLINK-2560 
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Browser New Tab Does Not Work for VoiceLink Actions: Using the 
"Open link in new window/tab" option from the web browser's right-click 
menu option is not supported in the VoiceLink application, and does not work 
with several VoiceLink action links. 

VLINK-2073 

Data Volume Degrades Performance: Transaction times for some 
Selection commands significantly increase the longer the application runs. 
This is due in part to an increase in the amount of transaction data in the 
database. 

To increase performance for longer runs, schedule a SQL transaction log 
backup to run every 30 minutes. 

In Microsoft SQL Server do the following: 

1. In Microsoft SQL Server Management Studio, select Management. 
2.  Right click on Maintenance Plans and select Maintenance Plan 

Wizard.  
3.  Specify a name for the plan.  
4. Click the Change button next to the scheduling field and specify a 

daily frequency of 30 minutes with a starting and ending time range 
that matches the time period of normal operations.  

5. Click OK.  
6. Click Next.  
7. Select Back Up Database (Transaction Log) from the list of 

maintenance tasks.  
8. Click Next on the current screen and the next screen.  
9. Select the Vocollect VoiceLink database from the list.  

10. Click Next on the current screen and the next screen. 
11. Click Finish.  

VLINK-2054 

Duplicate Database Interrupts Install Flow: If during the installation, 
the database name you entered in the Database Settings screen already 
exists, you will receive a message to that effect. If after you dismiss the 
message you click the Previous button, you will be taken to the Choose 
Install Folder screen rather than the Database Settings screen. You must 
exit the installer and restart it to enter the proper database settings. 

VLINK-2035 

Users Must Wait for Resequencing Success: Resequencing a large 
number of assignments can take up to a minute to fully process. Although 
you are not informed of the processing status in the user interface, do not 
attempt to perform other actions in the application until you receive an 
Assignments were resequenced success message. 

VLINK-2031 

Site Name Cannot Contain Encodings: Do not include UTF-8 encoded 
characters in a site's name. Windows is unable to create a directory with such 
a site name, and scheduler export jobs will fail. 

EPP-730 
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VoiceLink Product DVD Contents 
DVD Label Item Code Contents 

Vocollect VoiceLink® Server 
Application Enterprise 
DVD 

N/A This DVD is not included in the VoiceLink 4.2.1 
release. See VoiceLink listings in the Vocollect 
Product Ordering Guidelines. 

Vocollect VoiceLink® Server 
Application Site DVD 

N/A This DVD is not included in the VoiceLink 4.2.1 
release. See VoiceLink listings in the Vocollect 
Product Ordering Guidelines. 

VocollectVoiceLink® V4.2.1 
Voice Application 
Enterprise DVD 

SW-VLINK-
VAPP-4.2.1-
ENT-DVD 

• Voice process software for VoiceLink 
VoiceApplications (Cycle Counting, ForkApps, 
Line Loading, Loading, Put To Store, 
Selection) based on VoiceArtisan® technology* 

• VoiceLink Product Descriptions 
VocollectVoiceLink® V4.2.1 
Voice Application Site DVD 

SW-VLINK-
VAPP-4.2.1-
SITE-DVD 

• Voice process software for VoiceLink 
VoiceApplications (Cycle Counting, ForkApps, 
Line Loading, Loading, Put To Store, 
Selection) based on VoiceArtisan® technology* 

• VoiceLink Product Descriptions 
VocollectVoiceLink® Task 
Enterprise DVD 

N/A This DVD is not included in the VoiceLink 4.2.1 
release. See VoiceLink listings in the Vocollect 
Product Ordering Guidelines. 

VocollectVoiceLink® Task 
Site DVD 

N/A This DVD is not included in the VoiceLink 4.2.1 
release. See VoiceLink listings in the Vocollect 
Product Ordering Guidelines. 

Vocollect VoiceLink® 
Developer Toolkit 

N/A This DVD is not included in the VoiceLink 4.2.1 
release. See VoiceLink listings in the Vocollect 
Product Ordering Guidelines. 

* Distributable application only. Source code is not included. 
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Getting Help 
Additional Documentation 

Resource Description FIND IT HERE 
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Product 
Descriptions 

Details on how voice supports 
warehouse work flows for Selection, 
Put Away and Replenishment 
(ForkApps), Line Loading, Put To 
Store, Loading, and Cycle Counting 

        

Implementation 
Guide 

Guidance on planning, deploying, and 
configuring your VoiceLink solution         

Online Help Screen-by-screen instructions on how 
to use the VoiceLink interface, 
available integrated in the UI or as a 
download from Vocollect portals. 
Source files are provided on the 
Developer Toolkit DVD. 

        

Customization 
Guide 

Technical reference on VoiceLink 
system architecture, setting up a 
developer environment, customizing 
application components, and testing 
and deploying custom systems 

         

Web Services 
Guide 

Instructions for using programmatic 
interfaces to perform operations on a 
VoiceLink system, particularly bulk 
changes, rather than making manual 
changes through the user interface. 

         

Reporting Best 
Practices Guide 

Recommendations for writing reports 
against a VoiceLink database and 
creating custom reports 

         

Demo System 
Guide 

Information for authorized users on 
using the VoiceLink Demo Tool          
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Contact Information 
If you have difficulty with any of the procedures described in this document, contact Vocollect 
Technical Support. 

Note: If you purchased equipment or services through a Vocollect reseller, please contact 
your reseller first for support or to purchase a support plan. 

For order placement, order status, returns, Return Material Authorization (RMA) status, or 
other customer service issues, contact Vocollect Customer Service at:  

United States: 
E-mail: voccustsupp@vocollect.com 
Phone: 866 862 6553, Option 3, Option 2 

Americas (outside U.S.), Australia, New Zealand: 
E-mail: voccustsupp@vocollect.com 
Phone: 412 829 8145, Option 3, Option 2 

Europe, Middle East, and Africa: 
E-mail: 
CustomerServicesEMEA@vocollect.com 
Phone: +44 (0) 1628 55 2903 

Japan and Korea: 
Email: japan@vocollect.com 
Phone: +813 3769 5601 

  

To return equipment for repair contact Vocollect RMA to request an RMA number: 
Email: vocollect-rma@vocollect.com 

  

For product related technical questions, system support incidents, and related technical 
issues, contact Vocollect Technical Support at:  

United States: 
E-mail: support@vocollect.com 
Phone: 866 862 7877 

Americas (outside U.S.), Australia, New Zealand: 
E-mail: support@vocollect.com 
Phone: 412 829 8145, Option 3, Option 1 

Europe, Middle East, and Africa: 
E-mail: emeasupport@vocollect.com 
Phone: +44 (0) 1628 55 2902 

Japan and Korea: 
E-mail: japansupport@vocollect.com 
Phone: +813 3769 5601 

  

For sales or any other inquiry, please contact Vocollect at info@vocollect.com or 412 829 8145.  

Vocollect Corporate Headquarters 
703 Rodi Road 
Pittsburgh, PA  15235 US 
Phone: +1 412 829 8145 
Fax: +1 412 829 0972 
Web: 
http://www.intermec.com/vocollect/solutions/connect-
with-vocollect/contact-sales-consultant/index.aspx 

 

 

Vocollect Japan 
Shiba 2-Chome Bldg. 8F 
2-2-15 Shiba, Minato-ku, 
Tokyo 105-0014 Japan 
Phone: +813 3769 5601 
Fax: +813 3769 5608 
Email: japan@vocollect.com 

  

 
 

mailto:voccustsupp@vocollect.com
mailto:voccustsupp@vocollect.com
mailto:CustomerServicesEMEA@vocollect.com
mailto:japan@vocollect.com
mailto:vocollect-rma@vocollect.com
mailto:support@vocollect.com
mailto:support@vocollect.com
mailto:emeasupport@vocollect.com
mailto:japansupport@vocollect.com
mailto:info@vocollect.com
http://www.intermec.com/vocollect/solutions/connect-with-vocollect/contact-sales-consultant/index.aspx
http://www.intermec.com/vocollect/solutions/connect-with-vocollect/contact-sales-consultant/index.aspx
mailto:japan@vocollect.com
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Vocollect EMEA 
Gemini House 
Mercury Park 
Wycombe Lane, Wooburn Green 
Buckinghamshire, HP10 0HH UK 
Phone: +44 (0) 1628 55 2900 
Email: voc_emea@vocollect.com 

  

Vocollect Latin America 
Phone (North): +52 55 5241 4800 ext. 4915 
Phone (South): +1 412 349 2477 
Email: latin_america@vocollect.com 

Vocollect Asia-Pacific 
2903 Sino Plaza, 255-257 Gloucester 
Road 
Causeway Bay 
Hong Kong 
Phone (Hong Kong): +852 3915 7000 
Phone (China): +86 10 5957 4817 
Phone (Australia): +61 409 527 201 
Email: apac@vocollect.com 

  

Vocollect Singapore 
151 Lorong Chuan 
#05-02A/03 (Lobby C) 
New Tech Park 
Singapore 556741 
Phone (Singapore): +65 6305 2369 
Phone (India): +91 124 480 6738 
Email: singapore@vocollect.com 

  

mailto:voc_emea@vocollect.com
mailto:latin_america@vocollect.com
mailto:apac@vocollect.com
mailto:singapore@vocollect.com
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Copyright 
Copyright © 2013 Honeywell International Inc. All rights reserved.  

Vocollect®, Talkman®, Vocollect Adaptive Speech Recognition™, Vocollect Voice®, Vocollect 
VoiceLink®, Vocollect VoiceDirect®, VoiceClient®, VoiceCatalyst®, VoiceConsole®, 
VoiceArtisan®, Voice-Directed Work®, TaskBuilder™, and the Vocollect logo are registered 
trademarks of Vocollect.  

All other product names mentioned herein are trademarks or registered trademarks of their 
respective owners.  

Published by Vocollect  
703 Rodi Road  
Pittsburgh, PA 15235  
(412) 829-8145 
fax (412) 829-0972 
http://www.vocollect.com  

Vocollect has carefully checked the information in this document and believes it to be 
accurate. However, Vocollect assumes no responsibility for any inaccuracies that this 
document may contain. In no event will Vocollect be liable for direct, indirect, special, 
exemplary, incidental, or consequential damages resulting from any defect or omission in this 
document, even if advised of the possibility of such damages. 

Any alterations or inconsistent replications of this document cannot be considered accurate 
and are void. Vocollect may not be able to support issues related to altered documents that 
are not approved by subject matter experts.  

In the interest of product development, Vocollect reserves the right to make improvements to 
the information in this document and the products that it describes at any time, without 
notice or obligation.  


